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Introduction

About eFax
eFax is a fax and email fast messaging service brought to you by
esolutions.

eFax enables you to use your Microsoft Windows-based computer
system to send information to wide audiences very quickly and
efficiently.

The eFax software enables you to send faxes and emails from any
Windows application, at any time, to any recipient, anywhere in the
world.

eFax also provides full messaging management facilities including:

Recipient and Broadcast List Maintenance
Reporting; and
Cover Page customisation

esolutions’s
Service
Commitment

eFax Service Centre All eFax faults should be reported to the eFax Service Centre on
0800 TO EFAX (863329).

The Service Centre is available during normal business hours
7:00am to 7:00pm, Monday to Friday, excluding public holidays.

Service Availability The eFax service is available to broadcast fax and email documents
on a 24 hour/365 day basis.

Delivery Scheduling Immediate Delivery
Unless requested otherwise, all eFax deliveries will be queued for
delivery as they arrive at the eFax Host.

Deferred Delivery

You may choose to defer the broadcast of your message to a
specified time in the future.  Nominated delivery “go” times of up to
three days in advance may be specified.

Delivery Retries
eFax automatically retries all unsuccessful fax delivery attempts up
to five times.

Urgent Priority Delivery



Routine Priority Delivery

esolutions aims to complete delivery of routine fax jobs within two
hours of receipt at the eFax Network.

Bulk Delivery

Broadcasts to large numbers of recipients are handled separately
from the routine and urgent deliveries.

Bulk deliveries are transmitted as and when network capacity
allows.  This means all urgent and routine deliveries take priority
over bulk deliveries.

Bulk deliveries are those fax jobs containing more than 900 pages in
total.  Deliveries above this threshold are automatically handled as
bulk deliveries, regardless of the assigned/requested delivery
priority.  For example, a fax job containing 5 pages and sent to 200
recipients (1000 fax pages) would be handled by eFax as a bulk
delivery.



Using eFax

The eFax Screen When eFax is launched, the following screen is displayed.  The
screen consists of several different areas:

Attention, Company
and Destination

Buttons
When you move the cursor over Attention:, Company: or
Destination:, they will turn into buttons.  If you click on any of
these buttons, the Address Book appears.

Fields
The Attention:, Company: and Destination: fields allow you to
enter individual recipient information.  The Destination field can be
either a fax number or an internet email address.

Add recipient button If you have entered information into the Attention:, Company: or
Destination: fields, you can click the Add recipient button to add
the recipient to the Address Book.

Reference and Charge
Code

The Ref: and Charge Code: fields allow you to enter a reference
and charge code respectively, as part of any message that you send.

The reference will be returned in any reports that you receive for
this message.

The charge code will appear on your  bill against all fax numbers
that you sent this message to.



Send Time The Send Time: field allows you to specify the delivery date and
time of your message.  You can defer the delivery time of your
message by specifying a delivery date and time up to 3 days in the
future.
Note: The time must be specified in 24 hour format.

Include cover page
message check box

If the Include cover page message box is checked, then a message
can be typed into the message area.  If it is not checked, then the
message area will not be available for editing.

Message The Message area is for a message that you want to include as part
of any cover page that is sent.

Attached Files The Attached Files area lists all attached files that are to be sent
with your message.
To attach files:
1. Move the cursor to the Attached Files tab box and click the

right mouse button.
2. Select Add files to attach.
3. Select the files you want to attach.

Note: Attached files sent to fax recipients will be converted to fax
format once they reach the eFax Host.

Send to all recipients
check box

If the Send to all recipients box is checked, the message that is sent
will be delivered to all recipients in the Address Book.

Groups The Groups  area lists all the groups that are set up in your Address
Book.



Sending Messages eFax allows you to send messages using a variety of methods, and
to either a single recipient or group.

Sending to a Single
Recipient

Double click the eFax icon on the desktop to launch eFax.

1. Select or type in the recipient that you want to send the message
to in the Attention:, Company: and Destination: fields.

2. Type any reference or charge code information in the Ref: and
Charge Code: fields, if required.

3. Select a send date and time in the Send Time: field if you need
to defer delivery of your message.

4. If you:
• Want to send a message with your fax or email:

a. Ensure the Include cover page message  check box is
selected.

b. Type a message in the Message  field.
• Do not want to send a message with your fax or email turn

off the Include cover page message  check box.

5. To attach any files that you want to send with your message:
a. Move the cursor to the Attached Files tab box and click the

right mouse button.
b. Select Add files to attach.

Note: The attachment must be highlighted within the
Attached Files tab box for it to be sent.

6. Click the Send Fax button.



7. The Confirmation dialog box allows you to check the details of
your message before sending it.  Click the Send button to send
your message.

Sending to a Group The method for sending to groups is similar to that of sending to a
single recipient.

Double click the eFax icon on the desktop to launch eFax.

1. Click the required group or groups in the Groups  tab list box.
Note: The selected groups will be highlighted.

2. Type any reference or charge code information in the Ref: and
Charge Code: fields, if required.

3. Select a send date and time in the Send Time: field if you need



a. Move the cursor to the Attached Files tab box and click the
right mouse button.

b. Select Add files to attach.
Note: The attachment must be highlighted within the
Attached Files tab box for it to be sent.

6. Click the Send Fax button.

7. The Confirmation dialog box allows you to check the details of
your message before sending it.  Click the Send button to send
your message.

Sending a Message
from within an
fApplication

eFax allows you to send documents from within your application.
For example, from within Microsoft Word or Excel.  To send a
message from within your application you must print to the eFax
printer.

In Microsoft Word a fax button  is inserted on the tool bar.
Click the fax button to send a fax using eFax.
In other applications you must print to the eFax Printer.



When you print to the eFax printer or click the fax button in
Microsoft Word the eFax screen appears.  When the eFax screen is
displayed:

1. Either:
• Select or type in the recipient that you want to send the

message to in the Attention:, Company: and Destination:
fields.

Or
• Click the required group or groups in the Groups  tab.

Note: The selected groups will be highlighted.

2. Type any reference or charge code information in the Ref: and
Charge Code: fields, if required.

3. Select a send date and time in the Send Time: field if you need
to defer delivery of your message.

4. Type a message in the Message  field if you want a cover page
to appear on your fax or email.

5. To attach any files that you want to send with your message:

a. Move the cursor to the Attached Files tab box and click the
right mouse button.

b. Select Add files to attach.
Note: The attachment must be highlighted within the
Attached Files tab box for it to be sent.

6. Click the Send Fax button.

7. Click the Send button in the Confirmation dialog box to send
your message.

Send Options A number of send options can be set relating to appearance and
delivery options for your message.  Send options can be set from the
Send Options menu in eFax.



Fax Priority
You can set fax priority as one of Urgent, Normal or Non-urgent,
corresponding to urgent priority delivery, routine priority delivery
and bulk delivery as described in esolutions’ service commitment.

Notification

You can set notification as one of Delivery, Non-delivery or None.
The notification level determines what sort of report is sent back to
the sender of the message (via email) in relation to the result of their
fax job.

• Delivery: returns a report listing all faxes delivered and not
delivered.

• Non-delivery: returns a report listing only faxes not delivered.
• None: no report will be returned.

Cover Page

Allows you to select the cover page that will be sent with your
message.  The default cover page is eFax.

Resolution
This can be High or Low.
• Low resolution is the standard setting and is used for most

documents.
• High resolution is used for documents with detailed graphics or

pictures.  High resolution can take up to twice as long as low
resolution.  High resolution provides a clearer fax result than
normal.

Group Send Preference
Group send preference allows you to apply filters to groups within
your Address Book.

Option Description Email sent Fax sent
Fax Only Send only to the recipients in the group who

have a fax number.
No Yes

Email Only Send only to the recipients in the group who
have an email address.

Yes No

Fax then Email Send to all the recipients in the group.  Where a
recipient has both a fax number and email
address in the Address Book, the message will
be sent to their fax number only.

Only if
recipient has
no fax

Yes

Fax and Email Send to all fax and email recipients in the group.
If a recipient has both a fax number and email
address in the Address Book, the message will
be sent to both their fax number and email
address.

Yes Yes

Use Entry Default Send to the preferred destination for each
recipient as specified in the Address Book.

If email is
preferred
destination

If fax is
preferred
destination



Fax Number Formats The eFax network accepts fax numbers in the following format:

Started with a ‘+’, with full STD
For Example (sending from Auckland):

Local: +6493032180
National: +6448024059
International: +6123456789
0800: +64800108208

Started with the STD code
For Example (sending from Auckland):

Local: 09 303-2180
National: 04 802 4059
International: 006123456789
0800: 0800 108 208

Note: Spaces and hyphens are allowed in the fax number.

A Note about
Attachments

In some cases when attaching files with the eFax client, the faxed
attachment may not appear exactly the same as if it was printed on a
printer.  For example, Microsoft Excel documents.

To ensure the faxed document is acceptable either:
• Send a test fax to yourself to see if the faxed output is

acceptable for that attachment, or
• Send your document from within its application using the eFax

printer.  Any document you send using this method will be
faxed as printed.



The Address Book The eFax Address Book can be displayed by clicking on of the
Attention:, Company: or Destination: buttons, or by following the
menu path Address Book > View Current Address Book.
Notes:
eFax lists recipients in Address Books and groups.
• Address Books are lists of recipients.  If you have a large

number of recipients you may want to have multiple Address
Books.

• Groups are a subset of an Address Book.  You select recipients
from the Address Book to create a Group.

• When sending a fax or email you can select:
• an individual from an Address Book or
• a group.  The message will be sent to everyone in the

group.

If you want to… Then…
Select a recipient from
the Address Book

• Double click the recipient or
• Select the recipient and click the

Select button.
Insert a new recipient
into the Address Book

1. Click the Insert button to open
the Adding an Address Record
dialog box.

2. Type appropriate details in the
Company Name:, Contact
Person:, Fax Number: and
Email Address: fields.

3. Select either Use Fax or Use
Email in the Preferred
Destination field.

4. Select the type of email files the
recipient will receive.  The file
types are:



format.
Note: If you use TIFF or
PDF the recipient must have
the appropriate software to
view the attachment.

5. If required move to the Business
Address Details and Email
Details tabs to complete further
recipient details.

6. Click the OK button  to save the
recipient details.

Delete a recipient 1. Select the recipient.
2. Click the Delete  button to open

the Confirm Delete dialog box.
3. Click the Yes button to delete the

recipient.
Change the details of a
recipient

1. Click the Change button to open
the Changing an Address
Record dialog box.

2. Change details in the General
Details, Business Address
Details or Email Details tabs as
required.

Notes:
There are several file types for email
attachments:
• TIFF: Tagged Image File Format.
• FXW: Reserved, do not use.
• PDF: Adobe Acrobat PDF

format.
• RAW: The original file format.
Note: If you use TIFF or PDF the
recipient must have the appropriate
software to view the attachment.

Sort recipient details by
Attention, Company or
Destination

Click the Attention, Company or
Destination tabs as required.



Other Address Book features

Button Description
τ Return to the top of the list
ττ Move up one page
τ Move to the previous recipient in the list
? This button is not active at present
υυ Move to the next recipient
υυυυ Move down one page
υυ   Move to the end of the list

Creating Groups Groups can be created in the Address Book by following the menu
path Address Book > Group Setup.  This will display the Group
and Recipient Setup dialog box.

The Group and Recipient Setup dialog box has two main areas.
On the left side of the dialog box, the list of groups, and on the right
side of the dialog box the list of recipients.  The dialog box initially
displays all groups and all recipients.

If you want to… Then…
Add a new group to the
Address Book

Click the Add button in the Groups
area.

Change the name of a
group

Select the group and click the Change
button in the Groups  area.

Delete a group 1. Select the group.
2. Click the Delete  button in the

Groups  area to open the
Confirm Delete  dialog box.

3. Click the Yes button to delete the
group.



Email Address: fields.
3. Select either Use Fax or Use

Email in the Preferred
Destination field.

4. Select the type of email files the
recipient will receive.  The file
types are:
• TIFF: Tagged Image File

Format.
• FXW: Reserved, do not use.
• PDF: Adobe Acrobat PDF

format.
• RAW: The original file

format.
Note: If you use TIFF or
PDF the recipient must have
the appropriate software to
view the attachment.

5. If required move to the Business
Address Details and Email
Details tabs to complete further
recipient details.

6. Click OK to save the recipient.
Change recipient details Select the recipient and click the

Change button in the Recipients area.
Delete a recipient from
the Address Book

1. Select the recipient
2. Click the Delete  button in the

Recipients area to open the
Confirm Delete  dialog box.

3. Click the Yes button to remove
the delete from the Address
Book.

Adding Recipients to
Groups

Recipients can be added to groups as follows:

1. Ensure the All tab in the Groups  area, and the All tab in the
Recipients area are selected.

2. Select the group you want to add the recipient to.

3. Select the recipient you want to add to the group.

4. Click the Add to Group button.

Removing Recipients
from Groups

Recipients can be removed from groups as follows:



1. Ensure the All tab in the Groups  area, and the Associate tab in
the Recipient area are selected.

2. Select the group you want to remove the recipient from.

3. Select the recipient you want to remove from the group.

4. Click the Remove from Group button.

Viewing Members of
Groups

To display members of a group:
1. Ensure the All tab in the Groups  area and the Associate tab in

the Recipient are selected.
2. Click on a group in the Groups All tab to view its members in

the Recipients Associate tab.

This can be seen in the above dialog box.  The group 100%
Replacement contains 3 members – Fred Stone, George Benson and
Violet Anderson.

Viewing Group
Membership

To display all groups that a recipient belongs to:
1. Ensure the Associate tab in the Groups  area and the All tab in

the Recipients area are selected.
2. Click on a recipient to view all groups that the recipient is a

member of.

This can be seen in the following dialog box.  Fred Stone is a
member of the group 100%Repacement.



Importing Recipients
into an Address Book

eFax allows you to import a list of recipients into an Address Book
from a file in CSV (Comma Separated Variable) format.  CSV files
can be generated from most spreadsheet and database programs.
For example, from Microsoft Excel.

The process for importing recipients into an Address Book is as
follows:

1. Follow the menu path File > Import File.  The Please select a
csv file to import from dialog box is displayed.

2. Select the CSV file that contains the recipients you want to
import.

3. Click the Open button to open the Import From CSV to TPS
Options  dialog box.



4. In the Import From CSV to TPS Options  dialog box the fields
in your CSV file are displayed on the right of the dialog box.
The fields on the left side of the dialog box are the fields
available in eFax.
To map the fields in the CSV file with the appropriate fields in
eFax:
a. Select a field from the left side of the dialog box and the

appropriate field on the right side of the dialog box.
b. Click the >> Map >> button.
c. Repeat steps a and b to map all required fields.

Note: To unmap a field click the << Map << button.

6. Check the Include first line  box if you want to import the first
line of your CSV file.

7. Check the Add to group box and select a group if you want the
recipients in your CSV file to be imported into an existing
group.
Note: If you do not select the Add to group option the
recipients will be added to the Address Book only.

8. Click the Start import button.

Note:
Adding recipients into groups:
• You can map a field in your CSV file to a group by using the

Group >> button.  This allows you to specify in your CSV file
a group for each recipient to belong to.  When imported, that
recipient will become a member of the specified group in the
Address Book.

• If the group already exists, the recipient will become part of it.
If the group does not exist, eFax will create it.

Example CSV File Format
Faxnumber,Attention,Company
093032180,Robyn Williams,Sysdoc Ltd



Exporting the Address
Book

eFax allows you to export the entire Address Book to a file in CSV
format. Once this has been done, you can read the exported file
using a spreadsheet or database program.

The process for exporting the Address Book is as follows:

1. Follow the menu path File> Select Export File.  The Please
name the file to save dialog box will be displayed.

2. Select the required directory and type the name of the file in the
File name: field.

3. Click the Save button to save the file.

Exporting Groups eFax also allows you to export groups to a file in CSV format.  The
exported file can be read using a spreadsheet or database program.

To export a group to a file:

1. Select the group or groups that you want to export.

2. Follow the menu path File > Export Groups to open the Please
name the file to save  dialog box.

3. Select the required directory file and type the name of the file in
the File name: field.

4. Click the Save button to save the file.

Creating Multiple
Address Books

With eFax you are able to create multiple Address Books.  This
allows you to organise your address lists into separate files.  It may
be useful if your address list contains a large number of recipients.

New Address Books can be added or created as follows:



1. Follow the menu path Address Books > Create an Address
Book to open the Please Input file details dialog box.

2. Enter a name for the Address Book in the Address book
display name: field.

3. Type or select the path and file name of the Address Book in
the Address book file name (use full pathname): field.
Note: Click the Browse button to select the path and name of a
pre-existing Address Book, if required.

4. Click the OK button to create or add the Address Book.

Selecting an Address
Book

If you have multiple Address Books, only one Address Book can be
viewed (or be active) at any one time.

The currently selected Address Book is shown with an asterisk (*) in
front of it.  To select a different Address Book:



Deleting an Address
Book

Address Books can be deleted in a similar fashion to the selecting of
Address Books:

1. From the Address Books menu, select the Address Book that
you want to delete.

2. Select Delete from the pop-up menu that appears.

Notes:
• You cannot delete the currently selected Address Book.  Before

you can delete a selected Address Book you must first make
another Address Book the active Address Book.

• When you delete an Address Book from eFax you are only
disconnecting the Address Book file from the application.  The
actual Address Book file is not deleted from the computer’s
disk drive.  If you want to delete the Address Book file, you
must delete it using Windows Explorer.

Sharing Address
Books

eFax Address Books can be shared between more than one user.
This means that only one Address Book needs to be maintained for
common addresses.

To share an Address Book:

1. Create a new Address Book on, or put an already created
Address Book into a shared network directory.

2. For each user that requires access to the shared Address Book,
ensure that they have appropriate permission to access the
shared network directory, and add this Address Book to their
eFax Client.  For information on adding Address Books see
Creating Multiple Address Books.



Cover Pages eFax allows you to create your own cover pages to be used with any
messages that you send.

eFax cover pages consist of four separate parts:
• image
• address block
• message
• signature block

Image

The image is usually a company logo containing company phone
and address details, and is stored on the eFax Host.  Each time a
cover page is sent, the eFax software overlays the image onto the
cover page.

Address Block

The address block usually contains recipient and personalised sender
information.  It is totally configurable by the user, and held locally
on the user’s PC as a Rich Text Format (RTF) file.

Message
The message is the message that you want to appear on your cover
page, and is entered in the message area of the eFax main window.

Signature Block

The signature block is similar to the address block, and usually
contains the name and position details of the sender.  Scanned
signatures can be part of the signature block if you require a hand
written signature on your message.  The signature block is also held
locally on the user’s PC as an RTF file.

Attention: Rick Smith
Company: RS Holdings
Destination:093555178
Date: Wed, Jan 19, 2000
From: Joe Bloggs

Rick,

The equipment you purchased is on its way to
NZ via Australia. Delivery is expected within the
next 2 weeks and once we have received the
shipment, we will assemble ready for installation
at your manufacturing plant.

The current project plan is proceeding according
to schedule and we expect completion of the
project in 2 months.

Regards

Joe Bloggs
Project Manager

Image

Address
Block

Message

Signature
Block



Creating a Cover Page Creating a cover page requires:
• Sending an image to the eFax Host.
• Setting up address and signature block.

Send Image to eFax Host

The first part of creating a cover page is to send the cover page
image to the eFax Host.

1. Load the image into your application.  For example, Microsoft
Word.

2. Print it to the eFax printer.
Notes:
• In most Windows applications this is done by following the

menu path File > Print.
• If you are using Word, you can click the Fax button.

3. The eFax screen will be displayed.  Follow the menu path Setup
> Create a Cover Page.  The Please Input file details: dialog
box will appear.

4. Enter a name and description for your cover page in the Cover



7. Click the Send button in the Confirmation dialog box to send.

Set up Address and Signature Blocks
The second part of creating a cover page involves configuring the
address and signature blocks.  The address and signature blocks are
RTF files that are stored locally on a users PC or network server.
The default address block supplied with eFax looks as follows:

The Subst mail merge command is used in the address block to
enable personalisation of messages.  For more information on mail
merge see Mail Merge.

The address and signature block files can be modified as desired,
and are configured in eFax from the Cover Page Setup dialog box.
To display this dialog box, follow the menu path Setup > Cover
Page.



• Body Text Details for modification of the message
• Signature Details for modification to the signature block.

On each tab:
• Margins  settings are available to set the position of each block

on the cover page.  Set the margins as required.
Note: The top margin for the address block is the gap between
the top of the page and the start of the address block.  This
needs to be set large enough so that the address block is placed
below any images overlaid at the top of the page.

• Horizontal lines drop down box is available if horizontal lines
are required to mark the top and/or bottom of each block.  Set
the horizontal lines as required.

On the Address Details and Signature Details tabs you can:
• Edit RTF files by clicking the View/Edit button
• Select RTF files by clicking the ellipsis (…) button
• Edit or select new address and signature block files as desired

If you make any changes to the Address Details, Body Text Details
or Signature Details tabs, click the Update button to save the
changes.

Selecting a Cover
Page

If you have more than one cover page, you can to select a cover
page to send with your message.  To do this:

1. Follow the menu path Send Options > Cover Page.  A pop up
menu containing the list of cover pages will be displayed.

2. Select the cover page you want to use.
Note: The currently selected cover page will have an asterisk
(*) next to it.

Note:  If you want to make this cover page your default cover page,
follow the menu path Send > Save as My Defaults.

Deleting a Cover Page To delete a cover page:

1. Follow the menu path Setup > Cover Page Setup to display the
Cover Page Setup dialog box.

2. Select the cover page you want to delete and click the Delete
button.



Remote Files With eFax you are able to upload files to be stored as images on the
eFax Host.  These are called remote files.  Remote files are useful if
you have a requirement to frequently send files that don’t change
very often e.g. terms and conditions, application forms.  This feature
allows easier and more efficient sending of files using eFax.

The Remote Files tab is not displayed on the eFax main window by
default, and must be turned on.  To do this:

1. Follow the menu path Setup > Display Remote Files.  A pop
up menu will be displayed.

2. Select Yes to display the Remote Files tab.  The tab will appear
next to the Attached Files tab on the eFax main window.

Sending a Remote File
to the eFax Host

To send a Remote File to the eFax Host:

1. Load the file you want to send to eFax into your application.
For example, Microsoft Word.

2. Print it to the eFax printer.
Notes:
• In most Windows applications this is done by following the

menu path File > Print.
• If you are using Word, you can click the Fax button.

3. Follow the menu path Setup > Create a Remote File.  The
Please Input file details: dialog box will appear.

3. Enter a name and description for your remote image file and
click the OK button.  The Send Fax button on the eFax main
window will change to Send to the Server.

4. Click the Send to the Server button.

5. Click the Send button in the Confirmation dialog box to send.

The remote file will now be listed in the Remote Files tab on the
eFax main window.  To send this remote file, make sure the remote



Deleting a Remote File To delete remote files:

1. Move the cursor over the appropriate file and click the right
mouse button.

2. Select Delete selected remote files from the pop-up menu.

Note: Deleting remote files deletes the remote file from both the
eFax Client and the eFax Host.

Disconnecting a
Remote File

To disconnect remote files:

1. Move the cursor over the appropriate file and click the right
mouse button.

2. Select Disconnect selected remote files from the pop-up menu.

Note: Disconnecting remote files deletes the remote file from the
eFax Client only.  The remote file on the eFax Host is not deleted.



Autotext Files Cover page messages can be automatically loaded into the message
area of the eFax main window using Autotext files.  Using Autotext
files saves time, particularly when you need to repeatedly send
commonly used cover page messages.

To load an Autotext file into the message area:

1. Click on the eFax logo in the middle of the screen.  A pop up
menu will appear containing the list of available Autotext files.

2. Select an Autotext file.
Note: The message area of the eFax main window will be
populated with the contents of the Autotext file.

Creating an Autotext
File

Autotext files are text files that are stored on a computer’s disk
drive.  This could be a:
• Hard drive
• Floppy drive
• Network drive
The content of the text file is loaded into the eFax cover page
message when the Autotext file is selected.

To create an Autotext file:

1. Create and save a text file containing the message you want
loaded as Autotext.
Note: Files can be saved to a:
• Hard drive
• Floppy drive
• Network drive

2. From the eFax main window, follow the menu path Setup >
AutoText Setup.  The AutoText Setup dialog box will be
displayed.



Modifying an Autotext
File

Autotext files can be modified from the AutoText Setup dialog
box.

To modify an Autotext file:

1. From the eFax main window follow the menu Setup >
AutoText setup.  The AutoText Setup dialog box is displayed.

2. Select the Autotext file that you want to modify from the
Available AutoText Files list.  The Autotext name and path
will be displayed.

3. Modify the name of the Autotext file by editing the Selected
AutoText File field.

4. Modify the contents of the Autotext file by clicking the
View/Edit/Create File button, or select a new Autotext file by
clicking the ellipsis (…) button.

5. Follow the menu path File > Save to save the changes to the
autotext file.

6. Follow the menu path File > Exit to exit the editing window.

7. Click the Update button to save changes.

8. Click Close to return to the eFax window.

Note: If you have inserted an autotext file into the Message  section
and then go through the above procedure to make changes to the
autotext file you will need to re-insert the autotext into the Message
section to see the update.

Deleting an Autotext
File

Autotext files can be deleted from the AutoText Setup dialog box.

To delete an Autotext file:

1. From the eFax main window, follow the menu path Setup >
AutoText Setup to display the AutoText Setup dialog box.

2. Select the Autotext file that you want to delete from the
Available AutoText Files list.

3. Click the Delete  button to delete the Autotext file.

4. Click the Update button to update eFax.

Note: When you delete an Autotext file from eFax you are only
disconnecting the Autotext file from the application.  The actual file
containing the Autotext contents does not get deleted.  If you want
to delete this file, you must delete it using Windows Explorer.



The Send Log The Send Log is used to keep a record of messages that have been
sent from eFax.  This feature can be turned on or off.

The Send Log is turned off by default.  To enable it:

1. From the eFax main window follow the menu path View > Send
Log.  A pop up menu will be displayed.

2. Select Yes to enable the Send Log.

Viewing the Send Log The Send Log can be viewed from the eFax main window by
following the menu path View > ViewSendLog.

If you want to… Then…
Resend a message 1. Select the message.

2. Click the Re-Send button.
Note: The eFax main window will now
be populated with the original message
details.

3. Click the Send Fax button to resend
the message.

Delete a message 1. Select the message.
2. Click the Delete  button.

View the cover
page

1. Select the message.
2. Click the View Cover Page Message

button.
View the print file
raw code from a
message send via
an application, for
example, from
Microsoft Word

1. Select the message.
2. Click the View Print File button.
Note: To view a print file as an image you
must set up a program which can view
postscript files – to do this see Setting up a
Postscript Viewer.

Notes:
• The View Cover Page Message  and View Print File buttons

will only be enabled if the selected message has a cover page
message and/or associated print file.



Resending
Unsuccessful Faxes

eFax allows you to resend a message to all unsuccessful fax
recipients.  You are able to tell that your message had failures from
any delivery or non-delivery reports you receive from the eFax
service.  To resend an unsuccessful fax:

1. Follow the menu path File > Resubmit to open the Resubmit
dialog box.

2. Type the job number of the message that you want resent in the
Job Number: field.
Note: The job number is returned in the delivery or non-
delivery report you receive for your message.

3. If you want to:

• Resend to unsuccessful recipients only, check the Resend
to unsuccessful destinations  field.

• Resend to all recipients, check the Resend to all
destinations field.

4. Click the Send button.



Mail Merge The eFax software allows you to send documents that can be mail
merged by the eFax Host.

The eFax Client contains nine default fields that can be mail merged
into your documents.  They are the Attention, Company,
Destination, Title, Firstname , Lastname , From, Chargecode  and
Reference fields.  In addition you can also merge the system fields
Current Date, Page Number, and Page Count into your
document.

Creating Mail Merge
Documents

Mail merge documents are created by placing Substitute indocument
commands within your document.  An example of its use can be
seen in the Address Block for Cover Pages.  When creating a mail
merge document, you are in effect creating a template into which
different information can be placed.

When the eFax Host receives a document with mail merge
commands for processing, it merges the document with the merge
data, and creates a separate document to send for each recipient.

The syntax for the substitute command is as follows:

<subst:Field_______________________________>

This is interpreted by the eFax Host, which inserts the value of Field
into the document starting at the “<” and ending at the “>”.  The
underscores (_) define the size of the field.

The syntax for substituting system fields is as follows:

<subst:”%Field%”___________________________>

You can also use the Subl, Subc and Subr indocument commands
(for Substitute Left, Substitute Centre, and Substitute Right) to align
the merged data within the field between the < and >.

The default merge fields you can use with eFax client are:

ATTENTION The attention details
COMPANY The company name
DESTINATION The fax number or email address

Document

Merge
Data

Merged
Docs faxed or emailed



REFERENCE The reference

The system merge fields you can use are:

%DATE% The current date
%PAGE% Page number of the current page
%PGC% The total page count

For example, your document could contain the following substitute
commands:

TO: <subst:ATTENTION_______________________________>
COMPANY: <subst:COMPANY________________________________>
DESTINATION: <subst:DESTINATION_____________________________>

DATE: <subl:”%DATE%”____>  <subr:”Page %PAGE% of
%PGC%”>
FROM: <subst:FROM____________________>

Sending Mail Merge
Documents

Mail merge documents are sent as normal using the eFax Client.
That is, by attaching them as files or by printing them to the eFax
printer.  For more information on sending messages see Sending
Messages.

When merging fields, make sure that the recipients you are sending
to actually have data in the merge fields.  For example, if you want
the FIRSTNAME field merged into your document, each recipient
must have a First Name in the Address Book.

Other Mail Merge
Fields

Other fields in the eFax Address Book can be used for mail merge.
By default there are not used, but can be set for use as follows:

1. Follow the menu path Setup > Mailmerge Fields to open the
Additional values to output dialog box.

2. Check each field the Address Book that you want to use for
mail merge.



Personal Details You can also mail merge personal details into your documents.  This
is useful in multiuser environments when using shared cover pages.
Being able to merge personal details allows you to create a common
signature block for every user.  For more information on sharing
cover pages Sharing Cover Pages.

Three fields are supplied for personal details. They are:
• Direct Dial In (DDI) Number
• Fax Number
• Email Address

To enter personal details:

1. Follow the menu path Setup > Personal Details to open the
Personal Details dialog box.

2. Type appropriate details in the DDI, Fax Number and Email
Address fields.

3. Click the Save button to save the details.

The substitute merge fields for personal details are:

PD_DDI Personal DDI.
PD_FAXNUM Personal fax number.
PD_EMAILADDR Email address.



Uploading Lists With eFax you are able to upload lists to the eFax Host.  This is only
necessary if you are also using the eFax SWIFT service to send
hardcopy fax broadcasts.

To upload lists to the eFax Host:

1. From the eFax main window , select the group in the Groups
tab that you want to upload as a list to the eFax Host.

2. Follow the menu path File > Upload List  to open the Upload
list dialog box.

3. Enter a list number.
Note: This must be a number from 00-89, or 100-899.

4. Click the Upload button.

A report from the eFax service will be returned via email when the
list has been successfully loaded onto the eFax Host.  When the
report is received, the uploaded list will be available for use with the
eFax SWIFT service.



Reports

Report Types
When a user sends a message to the eFax service, a report is
typically returned to the user via email.  The type of report returned
can differ depending on what notification the user has requested,
and what sort of message the user sent to eFax.

Note: All reports, except the Group Upload report, return
information containing the eFax:
• Job number
• Submission date and time
• Reference field

Delivery Report The Delivery Report lists all faxes delivered and not delivered, sent
on job completion by the eFax Host.  This report is returned if the
user has requested delivery notification.

Delivery reports are also returned when cover page images or a
remote file images have been successfully uploaded to the eFax
Host.

Non-delivery Report The Non-delivery Report lists only faxes not delivered, sent on job
completion by the eFax Host.  This report is returned if the user has
requested non-delivery notification, and only when there have been
failed deliveries.
Note: The Non-delivery Report is sometimes called the exception
report.

Submission Report The Submission Report states that a message has been received by
the eFax Host and is being processed.  This report is returned if the
message has been sent to five or more recipients, and is in addition
to any delivery or non-delivery reports that have been requested.

Deferred Delivery
Report

The Deferred Delivery Report states that a message has been
received by the eFax Host, and is being held for delivery at the
specified send date and time.  This report is returned if the message
has a specified send time more than an hour ahead of the current
time.  This report is in addition to any delivery or non-delivery
reports that have been requested.

Error Report The Error Report states that there was an error with the message that
was sent.

Unsupported
Attachment Report

The Unsupported Attachment Report states that an attachment sent
to the eFax Host is not supported.



Advanced Features

eFax.ini File
Some of the advanced features covered in this section require
manipulation of the eFax.ini file.  This file is used by the eFax
application for its configuration, and can be found in the directory
where eFax was installed.  It is a text file and can be modified with
any text editor.

Sharing Cover
Pages

Cover pages can be shared if more than one user wants to use the
same cover page.  Generally when cover pages are shared, the cover
page image file is the same, but the address and signature blocks for
each user are different.

To share cover pages you must edit the GlobalCoverPages entry in
the eFax.ini file.

The entry must be changed:

From: GlobalCoverPages=<install path>\eFax.ini
To: GlobalCoverPages=<shared network path>\FXWGlobal.ini

Note: If you chose Network Installation when you installed eFax
this will already be set up.

This change will mean that eFax will look for its cover pages in the
FXWGlobal.ini file on a shared network directory.  The
FXWGlobal.ini file has entries describing cover page settings.  An
example FXWGlobal.ini file looks as follows:

[AvailableCoverPages]
CompanyLogo=CompanyLogo

[CompanyLogo]
AddressHeader=0.5,0.5,1.75,0.5
AddressHeaderLines=Bottom
AddressHeaderFilename=C:\CovPage\Addr.rtf
MessageBody=0.5,0.5,0.5,0.5
MessageBodyLines=None
MessageBodyFontname=Arial
MessageBodyFontSize=12
Signature=0.5,0.5,0.5,0.5
SignatureLines=None
SignatureFilename=C:\CovPage\Sign.rtf

The above FXWGlobal.ini file describes the cover page
CompanyLogo.  Each user of this cover page will share the
CompanyLogo image stored on the eFax Host, but will have their
own personalised Address and Signature blocks, located on their PC
hard drive (as indicated by AddressHeaderFilename and
SignatureFilename.



AddressHeader, MessageBody and Signature describe the margins
for each block.  Margins settings are in the order Left, Right, Top,
Bottom.  In the preceding example, the address header has a left
margin of 0.5, a right margin of 0.5, a top margin of 1.75 and a
bottom margin of 0.5 (units in inches).

Sharing Remote
Files

Remote files, like cover pages can be shared if more than one user
want to use the same remote file.

To share remote files you must edit the ImageFiles entry in the
eFax.ini file.

The entry must be changed:

From: ImageFiles=<install path>\eFax.ini
To: ImageFiles=<shared network path>\ImageFiles.ini

Note: If you chose Network Installation when you installed eFax
this will already be set up.

This change will mean that eFax will look for its remote files in the
ImageFiles.ini file on a shared network directory.  This
ImageFiles.ini file describes what remote image files are available.
An example ImageFiles.ini file looks as follows:

[ImageFiles]
Application=Service Application Form
TermsAndConditions=Terms and Conditions

The above ImageFiles.ini file contains two remote files –
Application and TermsAndConditions.

The format for Remote File entries in the ini file is:

<Remote File Name>=<Remote File Description>

Setting up a
Postscript Viewer

Before you can view print files on screen as images you must install
a program that can view postscript files.  For example, Ghostscript
GSView software.  This is freely available from the web site
www.cs.wisc.edu/~ghost

To set up a postscript viewer for eFax:

1. Install the postscript viewing program on your PC.

2. Edit the eFax.ini file.  Change the ViewPSCommand entry. This
must be changed.

From: ViewPSCommand=notepad
To: ViewPSCommand=<postscript viewer program>

Note: You may also need to insert a path in front of your postscript



Sending to a group
using a
Targets.csv file

With eFax Client, it is possible to send to a group (or list) by
attaching a file containing the list of recipients to your message,
along with any documents that you want to send.

The list you attach must be a file named TARGETS.CSV in the
following CSV format:

Destination,Attention,Company
093032180,Robyn Williams,Sysdoc Ltd
rwilliams@sysdoc.co.nz,Robyn Williams,Sysdoc Ltd
033892445,Dorothy Lang,Wyle E Coyote Inc
006124603455,Jim Fletcher,Road Runner
044601254,John Duck,Acme Inc

Note: The first line of the CSV file describes the eFax fields.

Using a list in CSV format means you don’t have to use the Address
Book to store your groups.  You can extract lists from a different
database as required.

To send a message using a targets.csv file:

1. Create a file named TARGETS.CSV in the correct CSV format
for eFax.

2. Start eFax.

3. Fill in any reference or charge code information that you require
in the Ref: and Charge Code: fields.

4. Set a send time and date in the Send Time: fields, if you need
to defer delivery of your message.

5. Type in a message in the Message  field, if you want a cover
page to appear on your fax or email.

6. Attach any files that you want to send with your message.

7. Attach the TARGETS.CSV file to your message.

8. Click the Send Fax button.

9. Click the Send button in the Confirmation dialog box to send.



Appendix One – Supported
Attachments

eFax supports the following list of attachments:

Note: In some cases, the attachment when faxed may not appear exactly as if the attachment was
printed on a printer.  Send a test fax to yourself to check if the faxed output is acceptable for that
attachment.



oo  ACS
Microsoft Access 1.0
Microsoft Access 2.0

oo  AMI
Ami Pro
Ami
Professional Write Plus

oo  BDR
Microsoft Office Binder

oo  BMP
Windows Bitmap
OS/2 Bitmap
OS/2 Warp Bitmap
Windows Cursor
Windows Icon
Corel Draw 2.0
Corel Draw 3.0
Corel Draw 4.0
Corel Draw 5.0

oo  CGM
Computer Graphics Metafile

oo  DBS
DBase III
DBase IV
DBase V

oo  DEZ
DataEase 4.x

oo  DIF
Navy DIF

oo  DRW
Micrografx drawing products

oo  DX
DEC DX 3.0 and below
DEC DX 3.1
DEC DX 4.x

oo  DXF
AutoCad Interchange ASCII
AutoCad Interchange Binary

oo  EN4
Enable word processor 4.x

oo  ENS
Enable Spreadsheet

oo  ENW
Enable word processor 3.0

oo  EXE2
DOS Executable
Windows Executable or DLL

oo  FAX
CCITT Group 3 Fax

oo  FFT
IBM DCA/FFT

oo  FLW
Freelance 1.0 & 2.0 for
Windows
Freelance 96 for Windows 95
Freelance 1.0 & 2.0 for OS/2

oo  FWK
Framework III

oo  GIF
Compuserve GIF

oo  HGS
Harvard Graphics DOS 3.0
Chart
Harvard Graphics DOS 2.0
Chart
Harvard Graphics DOS 3.0
Present.

oo  HTML
Internet HyperText Markup
Language

oo  IMG
GEM Image

oo  IWP
Wang IWP

oo  JW
JustWrite 1.0
JustWrite 2.0
Q&A Write 3

oo  LEG
Legacy
Wordstar for Windows

oo  LZH
LZH Compress
LZA Self Extracting Compress

oo  M11
Mass 11

oo  MANU
Lotus Manuscript 1.0
Lotus Manuscript 2.0

oo  MCW
MacWrite II

oo  MM
MultiMate 3.6
MultiMate Advantage 2

oo  MM4
MultiMate 4.0

oo  MSW
Microsoft Word 4.x
Microsoft Word 5.x
Microsoft Word 6.x
Microsoft Word 8.x
Windows Write

oo  MWKD
Mac Works 2.0 Database

oo  MWKS
Mac Works 2.0 Spreadsheet

oo  MWP2
Mac WordPerfect 2.0
Mac WordPerfect 3.0

oo  MWPF
Mac WordPerfect 1.x

oo  MWRK
Mac Works 2.0 WP

oo  OMF - OS/2 Only
OS/2 Metafile

oo  OW
OfficeWriter

oo  PCL
PC File 5.0 Doc

oo  PCX
Paintbrush
DCX (multipage PCX)

oo  PDX
Paradox 2 & 3
Paradox 3.5
Paradox 4
Paradox for Windows

oo  PDF
Adobe Acrobat PDF 1.0
Adobe Acrobat PDF 1.1
Adobe Acrobat PDF 1.2

oo  PFS
PFS: Write A
PFS: Write B
Professional Write 1
Professional Write 2
IBM Writing Assistant
First Choice word procesor
First Choice 3 word processor

oo  PGL
HP Graphics Language

oo  PIC
Lotus PIC

oo  PICT



oo  PNTG
MacPaint

oo  PP2
PowerPoint 3.0 for Windows
PowerPoint 4.0 for Windows
PowerPoint 4.0 for Macintosh

oo  PP7
PowerPoint 7.0 for Windows
95

oo  PPL
PFS: Plan

oo  QA
Q&A Write

oo  QAD
Q&A Database

oo  QP6
Quattro Pro 5.0 for Windows
Quattro Pro 6.0 for Windows
Quattro Pro 7.0 for Windows

oo  RBS
R:Base System V
R:Base 5000

oo  RFT
IBM DCA/RFT

oo  RFX
Reflex

oo  RTF
Rich Text Format

oo  SAM
Samna

oo  SC5
SuperCalc 5

oo  SDW
Ami Draw

oo  SHW3
Novell Presentations 3.0

oo  SMD
Smart DataBase

oo  SMS
Smart Spreadsheet

oo  SMT
SmartWare II

oo  SNAP
Lotus Snapshot

oo  TAZ
UNIX Compress
UNIX Tar

oo  TEXT
Text - DOS character set
Text - ANSI character set
Text - Macintosh character
set
Text - Unicode character set
UUEncode

oo  TGA
Targa

oo  TIF6
Tagged Image File Format
EPS (TIFF header only)
CCITT Group 3 Fax
CCITT Group 4 Fax
JPEG
JFIF (JPEG not in TIFF
format)

oo  TW
Total Word

oo  TXT
IBM DisplayWrite 2 or 3
IBM DisplayWrite 4
IBM DisplayWrite 5

oo  VW3
Volkswriter

oo  W6
Microsoft Word 6.0 for
Windows
Microsoft Word 7.0 for
Windows 95
Microsoft WordPad

oo  WG2
Lotus 123 for OS/2 release 2

oo  WK4
Lotus 1-2-3  3.0
Lotus 1-2-3  4.0
Lotus 1-2-3  5.0

oo  WKS
Lotus 1-2-3  1.0
Lotus 1-2-3  2.0
Symphony
Microsoft Works SS
Microsoft Works DB
VP-Planner
Mosaic Twin
Quattro (DOS)
Quattro Pro (DOS)
Generic WKS
Windows Works Spreadsheet
Windows Works Database

oo  WORD
Word for Windows 1.x
Word for Windows 2.0
Word for Macintosh 4.0
Word for Macintosh 5.0

oo  WORK
Microsoft Works DOS 1.0 WP
Microsoft Works DOS 2.0 WP
Microsoft Works Win 3.0 WP
Microsoft Works Win 4.0 WP

oo  WP5
WordPerfect 5.x

oo  WP6
WordPerfect 6.0
WordPerfect 6.1
WordPerfect 7.0

oo  WPF
WordPerfect 4.2

oo  WPG
WordPerfect Graphic 1.0

oo  WPG2
WordPerfect Graphic 2.0
WordPerfect Presentations

oo  WPW
Novell PerfectWorks 2.0 word
processor
Novell PerfectWorks 2.0 draw
Novell PerfectWorks 2.0
spreadsheet

oo  WS
Wordstar 3.0
Wordstar 4.0
Wordstar 5.0
Wordstar 6.0
Wordstar 7.0

oo  WS2
Wordstar 2000

oo  XL5
Microsoft Excel 2.x
Microsoft Excel 3.0
Microsoft Excel 4.0
Microsoft Excel 5.0
Microsoft Excel 7.0
Microsoft Excel 2.x Chart
Microsoft Excel 3.0 Chart
Microsoft Excel 4.0 Chart
Microsoft Excel 5.0 Chart
Microsoft Excel 7.0 Chart

oo  XY
XyWrite / Nota Bene
Signature

oo  ZIP
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Attached files, 13
Attached Files, 7
Attaching files, 7, 8, 9, 11
Attention, 6
Autotext Files, 30

Creating, 30
Deleting, 31
Modifying, 31
Selecting, 30

Availability, 4
bill, 6
Bulk Delivery, 5
Buttons, 6
Charge  code, 8
Charge code, 9, 11
Charge Code, 6
Company, 6
Confirmation dialog box, 8
Cover Page, 8, 12, 24

Address Block, 24
Creating, 25
Deleting, 27
Horizontal lines, 27, 39
Image, 24, 25
Include cover page check box, 7
Margins, 27, 40
Message, 8, 24
Modifying, 27
Selecting, 27
Sharing, 39
Signature Block, 24

Default settings, 12
Deferred delivery, 7, 8

Disconnecting
Autotext files, 31
Remote files, 29
The Address Book, 23

eFax printer, 10
eFax Screen, 6
eFax.ini file, 39
Exporting

Address Book, 21
Groups, 21

Fax Number Formats, 13
Fax Priority, 12
Fields, 6
FXW, 14, 15
FXW Global.ini file, 39
Global Cover Pages eFax.ini file entry, 39
Group, 9
Group Send Preference, 12
Groups, 7, 11

Adding recipients to, 17
Creating, 16
Exporting, 21
Removing recipients from, 17
Viewing group membership, 18
Viewing Members of, 18

High Resolution, 12
Image Files eFax.ini file entry, 40
Immediate Delivery, 4
Importing Recipients, 19
List numbers, 37
Low Resolution, 12
Mail Merge, 34

Creating merge documents, 34
fields, 34
Other fields, 35
Personal details, 36
Sending merge documents, 35

Mapping import details, 20
Message, 7, 8, 9, 11
MSWord fax button, 10
Non-delivery, 12
Non-delivery Notification, 38
None, 12
Non-urgent, 12
Normal, 12
Notification, 12
PDF, 14, 15
Postscript Viewer

Setting up, 40
RAW, 14, 15
recipient, 11
Recipient, 8



Uploading, 28
Report, 38
Reports, 12

Deferred delivery, 38
Delivery, 38
Error, 38
Group upload, 38
Non-delivery, 38
Submission, 38
Unsupported attachment, 38

Resending messages, 32
Resending Unsuccessful Faxes, 33
Resolution, 12
Retries, 4
Routine Priority Delivery, 5
Scheduling, 4
Selecting recipients, 14
Send button, 9
send date and time, 9, 11
Send date and time, 8
Send Fax, 8, 10, 11
Send Log, 32

Enabling, 32
Viewing, 32

Send Options, 11

Send Time, 7
Send to all recipients check box, 7
Sending, 35

from an application, 10
to groups, 9
to single recipients, 8

Sending Messages, 8
Service Centre, 4
Signature Block

Setup, 26
STD codes, 13
Substitute

centre, 34
left, 34
right, 34

Substitute indocument command, 26, 34
Targets.csv file, 41
TIFF, 14, 15
Uploading images, 25, 28
Uploading Lists, 37
Urgent, 12
Urgent Priority Delivery, 4
Viewing sent messages, 32
ViewPSCommand eFax ini file entry, 40


